MICROSOFT WINDOW

Microsoft Windows (MS-Windows) is a family
of graphical operating systems developed,
marketed, and sold by the company Microsoft.

Windows provides a Graphical User
Interface (GUI) through which users can
interact with the computer using icons, menus,
windows, mouse, and keyboard instead of
typing complex commands.

Windows is the most widely used operating
system for personal computers because it is

easy to learn, user-friendly, and supports a
large number of software applications.

Example

Opening a folder by double-clicking it with a
mouse.

Exam Tip

Windows = GUI-Based Operating System

FULL FORM OF WINDOWS
MS-Windows stands for:

Microsoft-Wide Interactive Network
Development for Office Work Solutions

Exam Tip
The full form is frequently asked in computer

awareness examinations.

FEATURES OF
WINDOWS

MICROSOFT

Graphical User Interface (GUI)

Allows users to work with icons, buttons,
menus, and windows.

Example

Opening My Computer using an icon.

Multitasking

Allows multiple
simultaneously.

programs to run

Example

Listening to music while preparing a
document.

User-Friendly Interface

Easy to learn and operate.
Example

Using menus instead of commands.
Hardware Support

Supports a wide variety of devices.
Example

USB drives, printers, scanners.
Networking Support

Allows computers to communicate over
networks.

Example

Sharing files over a local network.

Exam Tip

Windows = GUI + Multitasking +

Networking

VERSIONS OF
WINDOWS

MICROSOFT

Microsoft has released many versions of
Windows over time.

WINDOWS NT (NEW TECHNOLOGY)


https://www.microsoft.com/?utm_source=chatgpt.com

Windows NT was introduced in July 1993 and
was specially designed for businesses and
network environments.

It provided better security, stability, and
administrative control than earlier Windows
versions.

Features

Based on High-Level Language.
Supports DOS applications.
Supports Windows 3 applications.
Supports Win32 applications.
32-bit operating system.

High security.

Better stability.

Designed for networking
environments.

Example

A company network managed using Windows
NT servers.

Exam Tip

Windows NT = New Technology + Business
Operating System

WINDOWS 95

Windows 95 was released on 24 August 1995
and became one of Microsoft's most
successful operating systems.

It introduced a more user-friendly graphical
interface and improved support for internet
technologies.

Features

e 16-bit and 32-bit hybrid operating
system.

Consumer-oriented operating system.
Supports FAT32 file system.
Supports Multi-Display.

Supports Web TV.

Includes Internet Explorer.

Example

Home users using Windows 95 for internet
browsing.

Exam Tip

Windows 95 Released: 24 August 1995

WINDOWS 98

Windows 98 was released in 1998 as the
successor to Windows 95.

The Second Edition (SE) of Windows 98
became very popular because it fixed many
problems present in the original version.

Features

e Supports Internet Explorer 4.0.1.
First Windows OS to use Windows
Driver Model (WDM).

e Supports FAT32 conversion utility.

e Supports USB devices.

e Supports DVD drives.

e Improved hardware compatibility.
Example

Using USB flash drives with Windows 98.

Exam Tip
Windows 98 = First Windows Version Using
WDM

WINDOWS ME
EDITION)

(MILLENNIUM

Windows ME stands for Millennium Edition.

It was released in June 2000 and mainly
targeted home users.

Although it introduced several new features, it
became known for system instability and
programming errors.

Features

e Designed for Single CPU systems.

e Minimum memory requirement: 64
MB.

e Maximum memory support: 4 GB.

e Introduced Multilingual User Interface
(MUI).

e Improved multimedia support.

Example

A home computer running Windows ME for
entertainment purposes.



Exam Tip

ME = Millennium Edition

WINDOWS XP

Windows XP was released by Microsoft on 25
October 2001.

It became one of the most successful and
widely used operating systems because of its
stability, performance, and user-friendly
interface.

XP stands for eXPerience.

Example

Computers used in schools and offices during
the 2000s.

Exam Tip

Windows XP Released: 25 October 2001

VERSIONS OF WINDOWS XP

WINDOWS XP HOME EDITION

Designed primarily for home users.

Features

e Simple user interface.

e Multimedia support.

e Internet connectivity.

e Personal computing features.
Example

A family computer used for games and internet
browsing.

Exam Tip

Home Edition = Personal Use

WINDOWS XP PROFESSIONAL

Designed for business and professional users.

Features

e Advanced networking.

e Better security.
e Domain support.
e Remote desktop features.

Example

Office computers connected to company
networks.

Exam Tip

Professional Edition = Business Use

FEATURES OF WINDOWS XP

Multiple User Profiles

Different users can have separate accounts
and settings.

Example

Different accounts for parents and children.
Disk Space Management

Supports large hard drives efficiently.
Example

Storing large amounts of data.

Minimum RAM Requirement

Requires at least 64 MB RAM.

Example

Running Windows XP on older computers.
Hard Disk Requirement

Requires approximately 1.5 GB free disk
space.

Example

Installing Windows XP on a hard disk.
Video Support

Supports Super VGA and higher resolutions.
Example

Displaying graphics at higher quality.



Multimedia Suppor

Supports sound cards, speakers, CD-ROMs,
and DVD-ROM drives.

Example
Watching movies and listening to music.
Exam Tip

Windows XP = Stable + Secure +
User-Friendly

COMPARISON OF WINDOWS VERSIONS

Version | Release | Important Feature
Year

Windows 1993 Business OS

NT
Windows 1995 FAT32 Support
95
Windows 1998 USB & WDM
98 Support
Windows 2000 Multilingual User
ME Interface
Windows 2001 Multiple User
XP Profiles

WINDOWS VISTA

Windows Vista is a graphical operating system
developed by Microsoft for personal
computers, laptops, tablets, and media center
PCs.

It was released worldwide on 30 January
2007 as the successor to Windows XP. Vista
introduced a modern interface and improved
security features compared to previous
Windows versions.

Example

A desktop computer running Windows Vista
with the Aero graphical interface.

Exam Tip

Windows Vista Release Date = 30 January
2007

FEATURES OF WINDOWS VISTA

Improved Visual Interface

Windows Vista introduced an enhanced
graphical appearance known as Aero.

Example

Transparent window effects and improved
desktop appearance.

Exam Tip
Vista = Better Visual Experience
Hardware Requirements

Windows Vista can be installed on:

e Pentium 4 Processor or Higher
e 512 MB RAM
e 32 MB Video Card
e 40 GB Hard Disk
Example

A Pentium 4 desktop running Windows Vista.

Exam Tip

Vista requires higher hardware specifications
than Windows XP.

Enhanced Security
Vista introduced several security

improvements  over previous Windows
versions.

Example

User Account Control (UAC) notifications.
Exam Tip

Vista = Improved Security + Improved

Graphics

WINDOWS 7

Windows 7 is a graphical operating system
developed by Microsoft and released on 22
October 2009.


https://www.microsoft.com/?utm_source=chatgpt.com

It was designed as an improved version of
Windows Vista and quickly became one of the
most popular operating systems because of its
speed, stability, and user-friendly interface.

Example

Office computers using Windows 7 for daily
work.

Exam Tip

Windows 7 Release Date = 22 October 2009

FEATURES OF WINDOWS 7

64-Bit Processor Support

Windows 7 efficiently supports modern 64-bit
processors.

Example

Running large software applications smoothly.
Exam Tip

Windows 7 = Strong 64-Bit Support
Touch Support

Supports touch-screen technology.
Example

Touch-enabled laptops.

Exam Tip

Windows 7 Supports Touch Technology
Speech Recognition

Allows users to control the computer using
voice commands.

Example
Opening applications using voice instructions.
Exam Tip

Speech Recognition Introduced as a Major
Feature

Handwriting Recognition

Recognizes handwritten input on touch
devices.

Example
Writing notes using a stylus.
Exam Tip

Useful for Tablet PCs

MP4 Media Playback

Supports playback of MP4 multimedia files.
Example

Watching MP4 videos.

Exam Tip

MP4 Support Added

Windows Biometric Framework
Provides support for biometric devices.
Example

Fingerprint authentication.

Exam Tip

Biometric Framework = Fingerprint Security
Multiple Firewall Support

Provides enhanced network protection.
Example

Protecting against unauthorized network
access.

Exam Tip

Windows 7 = Better Security than Vista

WINDOWS 8



Windows 8 is a personal computer operating
system developed by Microsoft and released
on 26 October 2012.

It introduced a completely redesigned user
interface based on Microsoft's Metro Design

Language and focused on touch-screen
devices.

Example

Touch-screen tablets running Windows 8.

Exam Tip

Windows 8 Release Date = 26 October 2012

FEATURES OF WINDOWS 8

64-Bit Logical CPU Support

Supports modern 64-bit
architecture.

computing

Example

Running high-performance applications.
Exam Tip

Windows 8 Optimized for Modern Hardware
3D Graphics Support

Provides improved graphical performance.
Example

Better gaming and multimedia experiences.
Exam Tip

3D Graphics Support Improved

Internet Explorer 10

Comes with Internet Explorer 10 browser.
Example

Browsing websites using IE10.

Exam Tip

Windows 8 = Internet Explorer 10

Metro Design Language
Introduced a tile-based interface.
Example

Live Tiles on the Start Screen.

Exam Tip

Metro Ul = Most Important Feature of
Windows 8

USB 3.0 Support

Supports faster data transfer devices.
Example

High-speed USB flash drives.

Exam Tip

USB 3.0 = Faster Data Transfer

Cloud Computing Support

Provides better integration with cloud services.
Example

Synchronizing files online.

Exam Tip

Windows 8 = Cloud-Friendly Operating
System

WINDOWS 10

Windows 10 is a personal computer operating
system developed and released by Microsoft
on 29 July 2015.

It combines the traditional desktop
environment with modern features and

cloud-based services.

Windows 10 was designed to work across
desktops, laptops, tablets, and smartphones.

Example

Modern office computers running Windows 10.

Exam Tip



Windows 10 Release Date = 29 July 2015

FEATURES OF WINDOWS 10

Social Media Integration

Provides easier access to social networking
platforms.

Example

Using Facebook and Twitter applications
directly.

Exam Tip

Windows 10 Supports Social Connectivity
Game DVR Feature

Allows recording of gameplay footage.
Example

Recording the last 30 seconds of a game.
Exam Tip

Game DVR = Important Gaming Feature
Adaptive Interface

The interface automatically adjusts according
to the hardware device being used.

Example

Different layouts for desktops and tablets.
Exam Tip

Windows 10 = Adaptive User Interface
Improved User Experience

Combines traditional and modern Windows
features.

Example

Start Menu returned with  improved
functionality.

Exam Tip

Windows 10 = Best of Windows 7 + Windows
8

COMPARISON OF WINDOWS VERSIONS

Version Release Date Important
Feature
Windows 30 Jan 2007 Aero Interface
Vista
Windows 7 22 Oct 2009 Touch &
Biometric
Support
Windows 8 26 Oct 2012 Metro Design
Interface
Windows 29 Jul 2015 Adaptive
10 Interface
WINDOWS RELEASE TIMELINE
Version Year
Windows NT 1993
Windows 95 1995
Windows 98 1998
Windows ME 2000
Windows XP 2001
Windows Vista 2007
Windows 7 2009
Windows 8 2012
Windows 10 2015

Exam Tip

Remember the order:

NT -95 598 - ME —- XP — Vista—-7 — 8
—10

QUICK REVISION TABLE

Version Remember As




Vista Aero Interface

Windows 7 Touch + Biometrics

Windows 8 Metro Design

Windows 10 Adaptive Interface
DESKTOP

The Desktop is the first screen that appears
after the computer starts and the operating
system loads successfully.

It acts as the main working area of Windows
where users can access programs, files,
folders, and system settings.

The desktop serves as a virtual workspace
where different components such as icons,

taskbar, start menu, gadgets, and wallpaper
are displayed.

Example
After turning on a Windows computer, the

screen showing icons and taskbar is called the
Desktop.

Exam Tip
Desktop = First Screen After Windows
Starts

WALLPAPER

The background image displayed on the
desktop is called Wallpaper.

Users can change the wallpaper according to
their preferences.

Example

A nature photograph used as the desktop
background.

Exam Tip

Wallpaper = Desktop Background Image

CURSOR

The small arrow or blinking symbol visible on
the screen is called the Cursor.

It indicates the current position where an
action can be performed.

Types of Cursor

Mouse Pointer

Usually appears as an arrow.

Example

Selecting an icon using the mouse pointer.

Text Cursor

Usually appears as a blinking vertical line.

Example

Typing inside a document.

Exam Tip

Cursor = Position Indicator

COMPONENTS OF DESKTOP

The desktop contains several important
elements that help users interact with the
computer.

Main components are:

Icons

Taskbar

Start Menu

Wallpaper

Cursor

Gadgets (in some Windows versions)

Exam Tip

Desktop Components are frequently asked in
computer awareness exams.

ICON

An lcon is a small graphical symbol that
represents a file, folder, program, shortcut, or
device.

Icons make it easy to identify and access
applications without typing commands.



Users can open most icons by double-clicking
them.

Example

Double-clicking the Microsoft Word icon to
open the program.

Exam Tip

Ilcon = Graphical Representation of a
Program or File

DRAG AND DROP
Dragging

Moving an icon from one location to another
while holding the mouse button.

Example

Moving a folder from one area of the desktop
to another.

Dropping

Releasing the mouse button after dragging an
item.

Example

Placing a file into a folder.

Exam Tip

Drag = Move
Drop = Release

IMPORTANT DESKTOP ICONS

COMPUTER (MY COMPUTER / THIS
PC)

Computer is one of the most important
desktop icons.

It provides access to:

Hard Disk Drives
Removable Drives
Files

Folders

Printers

e System Resources

Through this icon, users can view all storage
devices connected to the computer.

Functions
e Access hard disk partitions.
e Open removable devices.
e Manage files and folders.
e Access system information.
Example

Opening Drive C: using the Computer icon.

Exam Tip

Computer Icon = Access to All Drives and
Devices

RECYCLE BIN

Recycle Bin is a special folder where deleted
files and folders are temporarily stored.

When a file is deleted, it is usually moved to
the Recycle Bin instead of being permanently
removed.

Users can restore deleted files if needed.

Functions

e Stores deleted items temporarily.

Restores deleted files.

e Permanently removes files when
emptied.

Example

Recovering a mistakenly deleted document
from Recycle Bin.

Exam Tip

Deleted Files First Go to Recycle Bin

RESTORE OPTION

Restore returns a deleted file or folder to its
original location.

Example



Restoring a deleted photograph from Recycle
Bin.

Exam Tip

Restore = Bring Back Deleted File

EMPTY RECYCLE BIN

After emptying the Recycle Bin, deleted files
are permanently removed.

Example

Selecting "Empty Recycle Bin."

Exam Tip

Empty Recycle Bin = Permanent Deletion

TASKBAR

The long horizontal bar usually located at the
bottom of the desktop is called the Taskbar.

It displays running applications and provides
quick access to important system functions.

Whenever a program is opened, its button
appears on the taskbar.

Example

Microsoft Word icon appearing on the taskbar
when Word is opened.

Exam Tip

Taskbar = Shows Running Programs

PARTS OF TASKBAR

The Taskbar generally consists of three major
sections.

START BUTTON

The Start Button is located at the left side of
the taskbar.

It opens the Start Menu.

Example

Clicking the Windows Ilogo to access
programs.

Exam Tip

Start Button Opens Start Menu

MIDDLE SECTION

The middle section displays buttons for
currently open programs and windows.

Example
Buttons for Chrome, Word, and Excel.

Exam Tip

Middle Section = Running Applications

NOTIFICATION AREA

The notification area appears on the right side
of the taskbar.

It displays system status icons.

Example
e Date and Time
e Volume Control
e Network Status
e Battery Status
Exam Tip

Notification Area = System Information Area

START MENU

The Start Menu is the primary gateway to
access programs, files, folders, settings, and
system tools in Windows.

It helps users quickly locate and open
applications.

Example

Opening Paint through the Start Menu.

Exam Tip



Start Menu = Main Control Center of
Windows

OPTIONS OF START MENU

ALL PROGRAMS

All Programs contains a list of software
installed on the computer.

Whenever a new application is installed, it
usually appears in this menu.

Example
Opening Microsoft Word from All Programs.
Exam Tip

All Programs = Installed Software List

FAVORITES

Favorites contains bookmarked or frequently
visited web pages.

It allows quick access to preferred websites.

Example

Saving an educational website in Favorites.

Exam Tip

Favorites = Bookmarked Websites

DOCUMENTS

Documents displays recently opened files and
documents.

Example

Recently edited Word documents.

Exam Tip

Documents = Recently Opened Files

SETTINGS

Settings  provides access to system
configuration tools.

It includes:
e Control Panel
e Printers
e Taskbar Settings
e Network Settings
Example

Changing desktop wallpaper through Settings.

Exam Tip

Settings = System Configuration Area

FIND (SEARCH)

Find or Search helps users locate files,
folders, programs, and documents.

Example
Searching for a file named "Result.docx."
Exam Tip

Find = Search Tool

LOG OFF

Log Off closes the current user's session
without shutting down the computer.

Another user can log in afterward.
Example

A student logs off after completing work.

Exam Tip

Log Off = Exit User Account

TURN OFF / SHUT DOWN

Turn Off or Shut Down safely closes all
programs and powers off the computer.

Example

Selecting Shut Down before switching off the
computer.



Exam Tip

Always Shut Down Properly Before Turning

Off Power

QUICK REVISION TABLE

Component Remember As
Desktop First Windows Screen
Wallpaper Background Image
Cursor Position Indicator
Icon Small Picture Representing
Program
Computer Access Drives and Devices
Recycle Bin Stores Deleted Files
Taskbar Shows Running Programs

Start Button

Opens Start Menu

Notification System Status Information
Area
All Programs Installed Software
Documents Recently Opened Files
Settings System Configuration
Find Search Tool
Log Off Exit Current User
Shut Down Turn Off Computer
WINDOW

A Window is a rectangular area on the
computer screen that provides an environment
for running programs, viewing documents, and
performing various tasks.

In  Microsoft Windows, every application,
folder, document, or dialog box usually opens
inside a window.

Windows allow users to work with multiple
programs simultaneously through a graphical
interface.

Example

When Microsoft Word is opened, it appears
inside a window.

Exam Tip

Window = Rectangular Work Area for
Programs

PARTS OF A WINDOW

A window consists of several important
components that help users interact with
programs and documents.

Main parts are:

Title Bar
Minimize Button
Maximize Button
Close Button
Scroll Bar

Menu Bar

Exam Tip

Window Components are frequently asked in
competitive examinations.

TITLE BAR

The Title Bar is located at the top of a window.

It displays the name of the currently opened
program, document, or folder.

The title bar also contains the Minimize,
Maximize, and Close buttons.

Example

"Document1 - Microsoft Word" displayed at the
top of a Word window.

Exam Tip

Title Bar = Shows Window Name

CLOSE BUTTON



The Close Button appears at the right side of
the title bar and is represented by the symbol
(X).

It is used to close the current window or
terminate the running program.

Example

Clicking (X) to close Microsoft Paint.

Exam Tip

Close Button = Exit Program

MINIMIZE BUTTON

The Minimize Button reduces the window and
places it on the taskbar without closing it.

The program continues running in the
background.

Example

Minimizing a browser while working in MS
Word.

Exam Tip

Minimize = Hide Window to Taskbar

MAXIMIZE BUTTON

The Maximize Button enlarges the window so
that it occupies the entire desktop area.

Example
Expanding Microsoft Excel to full screen.
Exam Tip

Maximize = Full Screen Window

RESTORE BUTTON

When a window is maximized, the Maximize
Button changes into a Restore Button.

It returns the window to its previous size.
Example

Reducing a maximized browser window.

Exam Tip

Restore = Return to Previous Size

SCROLL BAR

A Scroll Bar is used to move through a
document, webpage, or window when the
content is larger than the visible area.

It helps users view hidden portions of
information.

Example
Scrolling down a long webpage.
Exam Tip

Scroll Bar = View Hidden Content

TYPES OF SCROLL BAR

HORIZONTAL SCROLL BAR

The Horizontal Scroll Bar moves the document
left and right.

It is usually located at the bottom of the
window.

Example

Viewing hidden columns in an Excel
worksheet.

Exam Tip

Horizontal = Left « Right

VERTICAL SCROLL BAR

The Vertical Scroll Bar moves the document
up and down.

It is usually located on the right side of the
window.

Example

Reading a long article on a webpage.

Exam Tip



Vertical = Up { Down

MENU BAR

The Menu Bar contains a list of menus that
provide commands and options for performing
various tasks.

Different applications may have different menu
options.

Example

Menu Bar in MS Word.

Exam Tip

Menu Bar = Collection of Menus

FILE MENU

The File Menu contains commands related to
file management.

Common Options

New
Open
Save
Save As
Print
Close

Example

Saving a document using Save option.

Exam Tip

File Menu = File Operations

EDIT MENU

The Edit Menu contains commands for editing
content.

Common Options

Undo
Cut

Copy
Paste
Clear

Example

Copying text from one document to another.

Exam Tip

Edit Menu = Modify Content

VIEW MENU

The View Menu controls how information is
displayed on the screen.

Common Options

e Normal View

e Toolbar

e Print Layout

e Zoom
Example

Changing document view in MS Word.

Exam Tip

View Menu = Display Settings

INSERT MENU

The Insert Menu is used to insert various items
into a document.

Common Options

Header
Footer
Picture

Table

Page Number

Example

Adding a header to a report.

Exam Tip

Insert Menu = Add Objects

HELP MENU

The Help Menu provides assistance and
information about the software.

Example



Searching for help regarding formatting
options.

Exam Tip

Help Menu = User Assistance

DIALOG BOX

A Dialog Box is a small window that appears
on the screen to communicate information or
request input from the user.

It usually appears when the system needs
confirmation before performing an action.

Example

A message asking whether you want to save
changes before closing a document.

Common Buttons

Yes
No
Cancel
OK
Close

Exam Tip

Dialog Box = Communication Window

MAIN PROGRAMS
WINDOWS

INSIDE

Windows includes several built-in applications.

NOTEPAD

Notepad is a simple text editor used for
creating and editing plain text documents.

It does not support advanced formatting.

File Extension

Axt

Example

Creating notes in plain text.

Exam Tip

Notepad = Plain Text Editor

WORDPAD

WordPad is a text editor that provides more
formatting features than Notepad.

It supports fonts, pictures, alignment, and rich
text formatting.

File Extension

rtf

Example

Creating formatted letters and reports.

Exam Tip

WordPad = Rich Text Editor

PAINT

Paint is a graphics program used to create and
edit digital drawings and images.

Common File Extensions

e .png
* .Jpg
e .bmp

Example

Drawing a simple diagram.
Exam Tip

Paint = Drawing Program

CALCULATOR

Calculator is a utility program used for
mathematical calculations.

Functions
e Addition
e Subtraction
e Multiplication
e Division



Example
Calculating examination marks.
Exam Tip

Calculator = Arithmetic Tool

WINDOWS MEDIA PLAYER

Windows Media Player is a multimedia
application used for playing audio and video
files.

It can also organize media collections and
burn CDs.

Functions
e Play Music
e Play Videos
e Organize Media
e Burn CDs
Example

Playing MP3 songs.
Exam Tip

Windows Media Player = Multimedia Player

FILES

A File is a collection of related information
stored on a storage device.

Files are the basic units used to store data in a
computer.

Every file has:

e File Name
e File Extension

Example

Result.docx

Exam Tip

File = Collection of Data

FILE NAME

The name assigned by the user to identify a
file.

Example
Resume.docx
Exam Tip

File Name Helps Identify the File

FILE EXTENSION

The characters after the dot (.) in a file name
are called File Extension.

It identifies the file type.
Example

Report.docx

Here:

e Report = File Name
e .docx = File Extension

Exam Tip

Extension Indicates File Type

COMMON FILE EXTENSIONS

Extension File Type
.docx MS Word Document
Xlsx MS Excel Workbook
.pptx MS PowerPoint Presentation

Axt Notepad Text File
rtf WordPad File
.eml Email File
.exe Executable File
.htm Web Page
.html Web Page
.png Image File
.Jjpg Image File




.bmp Bitmap Image

Exam Tip
File Extensions are among the most frequently
asked computer awareness questions.

ZIP FILE

A ZIP File is a compressed file format used to
reduce the size of one or more files.

Compression saves storage space and
speeds up file transfer.

Example
StudyMaterial.zip
Exam Tip

ZIP = Compressed File

Important Fact

ZIP stands for Zone Information Protocol
according to many traditional exam books
(though technically ZIP is commonly referred
to as a compressed archive format).

EXECUTABLE FILE

An Executable File contains instructions that
the computer can directly execute.

These files start programs or applications.
Common Extension

.exe

Example

Setup.exe

Exam Tip

.EXE = Executable Program File

QUICK REVISION TABLE

Window Rectangular Work Area
Title Bar Window Name
Close Button Exit Program
Minimize Button Send to Taskbar
Maximize Button Full Screen
Scroll Bar View Hidden Content
Menu Bar Collection of Menus
Dialog Box Message Window
Notepad Plain Text Editor
WordPad Rich Text Editor
Paint Drawing Program
Calculator Arithmetic Tool
Media Player Multimedia Software
File Collection of Data
ZIP File Compressed File
.exe Executable File
FOLDERS

Term Remember As

A Folder is a container used to store and
organize files, documents, images, videos,
and other folders on a computer.

Folders help users keep data organized and
make it easier to locate files when needed.

Just as physical files are stored inside folders

in an office, computer files are stored inside
folders in a computer system.

Example

A folder named "Study Notes" containing PDF
files and documents.

Exam Tip

Folder = Container for Storing Files



FEATURES OF FOLDERS

Store Files
Folders can contain different types of files.
Example

A folder containing Word documents and
images.

Store Other Folders

A folder can contain one or more folders inside
it.

Example

A folder named "Photos" containing folders for
2024 and 2025.

Organize Data
Folders help arrange files systematically.
Example

Separate folders for Music, Videos, and
Documents.

Easy File Management

Files can be copied, moved, deleted, or
searched easily.

Example

Moving files from one folder to another.

Exam Tip

Folders Organize and Manage Data
Efficiently

SUB-FOLDER

A Sub-Folder is a folder created inside
another folder.

Sub-folders help organize files into smaller
categories.

Example

Documents Folder
l, Exam Notes Folder
l, Assignments Folder

Exam Tip

Folder Inside Another Folder = Sub-Folder

WINDOWS LIBRARY

A Windows Library is a special feature that
helps users organize and access files and
folders stored in different locations through a
single view.

Libraries make file management easier
because users can access related files from

multiple folders without changing their actual
storage location.

Example

Viewing all pictures stored in different folders
through the Pictures Library.

Exam Tip
Library = Collection of Related Files and
Folders

TYPES OF WINDOWS LIBRARY

Windows provides several default libraries for
organizing different types of content.

DOCUMENTS LIBRARY

Documents Library is used to organize
text-based files and office documents.

Stores
e Word Documents
e Excel Files
e PowerPoint Presentations
e PDF Files
o Text Files
Example

Project reports stored in Documents Library.

Exam Tip

Documents Library = Text and Office Files



PICTURES LIBRARY

Pictures Library is used to organize digital
images and photographs.

Stores
e JPG Images
e PNG Images
e BMP Images
e Digital Photos

Example

Vacation photographs stored in Pictures
Library.

Exam Tip

Pictures Library = Images and Photos

MUSIC LIBRARY

Music Library is used to organize audio files
and songs.

Stores
e MP3 Files
o WAV Files

e Audio Recordings
Example
Favorite songs collection.
Exam Tip

Music Library = Audio Files

VIDEO LIBRARY

Video Library is used to organize video files
and recordings.

Stores
e Movies
e Video Clips

e Recordings

Example

Educational video lectures.

Exam Tip

Video Library = Video Content

WINDOWS EXPLORER

Windows Explorer is a file management
application included in Microsoft Windows.

It helps users view, organize, search, copy,
move, rename, and delete files and folders.

Modern versions of Windows call it File
Explorer.

Functions

Browse files and folders.
Create folders.

Copy and move files.
Search files.

Manage storage devices.

Example

Opening Drive C: using File Explorer.

Exam Tip

Windows Explorer = File Manager of
Windows

CLIPBOARD

Clipboard is a temporary storage area in
computer memory used to hold copied or cut
data.

The data remains on the clipboard until it is

pasted elsewhere or replaced by new copied
data.

Operations Using Clipboard

Copy

Creates a duplicate of selected content.
Example

Copying text from a document.

Cut

Removes selected content and places it on the
clipboard.

Example



Moving a paragraph from one location to
another.

Paste

Inserts copied or cut content from the
clipboard.

Example

Pasting copied text into a new document.

Exam Tip

Clipboard = Temporary Storage for Copy
and Cut Operations

IMPORTANT WINDOWS FACT

To shut down the computer:
Steps

1. Click Start Button.
2. Select Shut Down.

Exam Tip

Start — Shut Down

MS-WINDOWS SHORTCUT KEYS

Shortcut keys help perform tasks quickly
without using the mouse.

DELETE KEY

Deletes characters to the right of the cursor.

Example

Removing a character after the cursor.

Exam Tip

Delete = Right Side Deletion

BACKSPACE KEY

Deletes characters to the left of the cursor.

Example

Removing a typing mistake.

Exam Tip

Backspace = Left Side Deletion

CTRL + A

Selects all items or text.

Example

Selecting an entire document.

Exam Tip

Ctrl + A = Select All

F3

Searches for files and folders.

Example

Searching for Resume.docx.

Exam Tip

F3 = Search

CTRL + RIGHT ARROW

Moves the cursor to the beginning of the next
word.

Example
Navigating quickly through a paragraph.
Exam Tip

Next Word Navigation

CTRL + LEFT ARROW

Moves the cursor to the beginning of the
previous word.

Example

Moving backward through text.

Exam Tip



Previous Word Navigation

CTRL + ALT + DELETE

Opens security options and can be used to
restart the computer or access Task Manager.

Example

Used when a program stops responding.

Exam Tip

Ctrl + Alt + Del = Security Screen

ALT + ENTER

Displays properties of the selected item.
Example

Viewing file properties.

Exam Tip

Alt + Enter = Properties

ALT +F4

Closes the active window or exits the current
program.

Example

Closing Microsoft Word.

Exam Tip

Alt + F4 = Close Program

ALT + SPACEBAR

Opens the shortcut menu of the active window.
Example

Accessing minimize and maximize options.
Exam Tip

Alt + Spacebar = Window Menu

F2

Renames the selected file or folder.

Example

Changing Notes.docx to StudyNotes.docx.

Exam Tip

F2 = Rename

CTRL + ESC

Opens the Start Menu.

Example

Opening Start Menu using keyboard.

Exam Tip

Ctrl + Esc = Start Menu

F5

Refreshes the active window.

Example

Refreshing desktop icons.

Exam Tip

F5 = Refresh

ESC KEY

Cancels the current operation.

Example

Closing a menu without selecting an option.

Exam Tip

Esc = Cancel

WINDOWS KEY

Opens or hides the Start Menu.

Example



Pressing Windows key to access installed Windows + D

Show Desktop

programs.

Windows + L Lock Computer
Exam Tip
Ctrl + Alt + Delete Security Options
Windows Key = Start Menu
Alt + Enter Properties
WINDOWS + D Alt + Spacebar Window Menu

Displays the Desktop by minimizing all open
windows.

QUICK REVISION TABLE

Pressing it again restores the windows.

Topic Remember As
Example
Folder Container for Files
Quickly accessing desktop files.
Sub-Folder Folder Inside Folder
Exam Tip
) Documents Library | Office Files
Windows + D = Desktop
Pictures Library Images
WINDOWS + L > -
Music Library Audio Files
Locks the computer.
Video Library Videos

Example
Windows Explorer

File Manager

Locking the system before leaving the desk.

Clipboard Temporary Storage
Exam Tip
F2 Rename
Windows + L = Lock Computer
F3 Search
MOST IMPORTANT SHORTCUT KEYS F5 Refresh
Shortcut Key Function Alt + F4 Close Window
= Select Al Windows + D Show Desktop
R Rename Windows + L Lock Computer
F3 Search
F5 Refresh
Alt + F4 Close Program
Ctrl + Esc Open Start Menu
Windows Open Start Menu




